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1 Description

With the USB-RS232 converter you have a cable that is generated a RS232 port over a virtual COM
port from a PC USB port. In contrast to real "hardware based" COM ports, this COM port must be
not addressed via address (eg. 3E8) and interrupt (eg. IRQ4), instead via "logical" names. By that
not any kind of software can handle with this virtual COM port.

The converter respresent at its end a fully occupied interface as in the PC.

2 System requirements

2.1 Operating system(s)

* Windows 98 + SE

*  Windows ME/NT/2000
* Windows XP

* Windows Vista

* Windows 7

2.2 Software

* Software that can handle with the virtual COM port. For Step5 from Siemens (MS-DOS-
based software) there is a special driver "S5-patch" which allows this communication.

2.3 Hardware

* USB 1.1 - connection type A

3 Installation

3.1 Hardware

Plug in the converter with the USB connector into the USB port on your computer. The cable is
supplied with voltage from the USB interface.

3.1.1 Driver for Windows XP

1. Download the USB-driver for the product of the you known web-site. Extract the file on your
harddisc.

2. Connect your USB device to the PC and perform the now starting Windows Setup Wizard in the
previously extracted folder.
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Softwareinstallation

] E Die zu inztallierende Software hat den ‘Windows-Logo-Test nicht bestanden,
L] der die Kompatibilitat mit Windows =P Uberpriift. fwfaum ist dieser Test

wichtig?]

e 3. Durlpg the }nstallatlon you were asked if you want
Funktion des Systems direkt oder in Zukunft beeintrichtigen.

el ": tens. die Installa e?:;;lac. Lt to continue this.

und sich mit dem Hard: } ller Fiir Sof . die den

Windows-Logo-Test bestanden hat. in ¥erbind zu setzen.

Confirm this message with "Continue".

[ Installation fortsetzen ] | Installation abbrechen |

4. Once the USB driver is installed, you have on this PC a new virtual com-port. This com-port can
be viewed in the Device-Manager of your PC and then select it in your S5-application and use it.
Do you use the original Siemens S5-software, then you still need to download the "S5-patch" and
also install it.

3.1.2 Driver for Windows 98

Under Windows 98 in a MSDOS-box can not directly accessed on virtual COM ports like at XP or
2000. Because of that the installation of a driver "S5 VCOM for Win98" is necessary.

Installation:
1.) Connect the PG-USB-cable / USB-RS232-converter to an USB port on the computer.

2) If not already done, install the drivers for the PG-USB-cable /USB-RS232-converter (This driver
allows WINDOWS programs to access on the S5 control )

3) Test the connection optionally with the S5 controller with a Windows program (eg: PG2000 from
this CD)

4.) Then start the SETUP.EXE file on the installation CD for "S5VCOM for Win98"
5.) Select the installation path and click "Next"

6.) Select designation and location for the start menu and click on "Next"

7.) After completion of the installation, the system restarts

S5 VCOM was registered in the Startup folder and will be launched at every restart.
Uninstall

1.) Under “Start => Settings => Control Panel “ click on software

2.) Select "S5 VCOM for Win98" and click "Remove / Change"

3.) Respond with "Yes" to the question to remove the software

4.) When no longer needed at the same place can be also removed the "FTDI USB <-> Serial"
driver

5.) Restart system (recommended)
Settings / Start:

After the installation and followed restarting of the computer, the SSVCOM driver starts
automatically. If an error occurs while installing or starting the driver, it will be displayed.

If properly installed, appears at the right bottom of the screen another tray icon.
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On this icon you can see if the PG-USB-cable / USB-RS232-converter is recognized or not, and
whether the communication is currently running:

3G 1842 | PG-USB-cable / USB-RS232-converter is not recognized or not plugged.

PG-USB-cable / USB-RS232-converter is detected, but it is currently not
el 1849 ,
%L communicated via this interface.

PG-USB-cable / USB-RS232-converter is detected and it is currently
[BEE 1849 communicating.

S = sender (from computer to S5)
E = receiver (from S5 to computer)

By clicking this Tray-Icon appears a new dialog:

Under the area "Status" is displayed via which cable is being communicated and whether there is
established a connection.

2’ 55VCom
— Statu

ShlLAr | e W etzmerl IF‘I gt konfigurierenl

PG USE | nicht serburden

Under the area "Virtual port" on the left side is
displayed the COM port that can be used by the
Windows software, and on the right side the COM
port (IO port) is used by the MSDOS-box.

— wirtueller Port
COrM4 < COM3 [03EE IRG4]

— Programm

BEEMDEM | Sprache |

This must be used in the S5 software.

Depending which COM - ports are already exists, the next free COM port is used:

existing COM used by SSVCOM

NO COMI1 [03F8h,IRQ4]
COMI COM2 [02F8h,IRQ3]
COM2 COMI1 [03F8h,IRQ4]
COM1,COM2 COM3 [03E8h,IRQ4]
COM1,COM3 COM2 [02F8h,IRQ3]
COM2,COM3 COMI1 [03F8h,IRQ4]

COM1,COM2,COM3 COM4 [02E8h,IRQ3]

Under the area "Program" the virtual COM port can be closed, the language of the program can be
changed or the program can be minimized as tray icon.

3.1.3 Uninstallation of the USB driver and installation of a new version

Download the uninstallation tool from the homepage. You can find it on the side of the product PG-
USB or USB-RS232-converter in the download menu at the "Additional Downloads".

Disconnect the cable from the PC and follow the software and the USB driver and the required
entries will be deleted. Then you can download the relevant USB drivers from the download menu
at the "Necessary Downloads" and extract this file to your hard disk. Now plug in the cable and
follow the hardware installation wizard where you point into the folder where you unzipped the
"new" USB driver. Now you can continue to work with the PG-USB or USB-RS232-converter. The
possible patch of Step5 software must not be executed!
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3.1.4 Installation of the Step5 © addition driver for PG-USB/SS-LAN + +/ USB-
RS232-converter

In order to make the the PLC-VCOM furnished virtual COM interface available for Siemens Step ©
5 in the DOS box, must be installed this addition driver.

! Important ! PLC-VCOM must be installed before this Step © 5 addition driver. The installation
of the PLC-VCOM software is explained in the chapter ,,PLC-VCOM installation* .

Before you start the installation, make sure to stop any possible still running S5 original
software, otherwise the driver can not be installed.

1. Please download from the you known web-site the "S5-patch" and extract the file on your PC.

2. Now start the application "SSUSB.exe" from the previously extracted folder

Gerdteauswahl x|

Welches Gerat venwenden sie 7

X

3. Device selection

Now select the type of device.

— Gerat

" PGE-LSE

Select "S5-LAN + + / PG-USB-cable / USB-RS232-
converter" and confirm with "OK".

4.In the next dialog, start the installation by clicking on the

"Install" button.

Diezer Treiber stellt der

55-Original-5 oftware das 55-LAN-Kabel
alz COM-Schhittstelle unter Windows
FPA2000 zur Yerfiigung.

Beenden Sie die eventuell noch
laufende S55-Oniginal-Software |

Installizren

The installation wizard will now copy the required data.
Ende

i Please wait a moment.

dill]

5. Specify the folder where the software S5 is installed. Please wait while the installation routine
searches for the S5 software version.

6. Next, select the COM port and click "OK".

7. Soon as the installation is complete, you press "Finish".

8. When the "Install" button is disabled (gray font), the installation is complete.
9. Now close the wizard with "Finish".

With "Uninstall" you delete the already installed drivers.

If the COM port of the PLC-VCOM is changed afterwards, the Step5 © drivers must be
reinstalled!

Attention!

For the Step5 Siemens software the COM port must be are between COM1 and COM4. Check and
correct it if necessary.

To do this go into the Control Panel, then into system, select the hardware tab and click the button
Device Manager. In the Device Manager under "Ports (COM & LPT)" appears the virtual COM
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port "USB Serial Port (COMx)".

Right click on the USB Serial Port and then select "Properties" in the context menu. There you click
on the tab "Port Settings". In the next dialog you select the button "Advanced" and in the following
dialog the COM port can be selected.

4 Control elements

4.1 Status LEDs

green LED off: no data transmission

green LED blinking: computer receives data from the COM port
yellow LED off: no data transmission

yellow LED blinking: computer sends data to the COM port

S Implementing

Connect your module as described in the chapter " Hardware installation " to the PLC and to the
programming device or to your computer.

If you want to respond to a PLC via the module you have to comply the requirements as
descript in the chapter "system requirements" . In addition,please make sure that the
module is properly connected
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5.1 Programming software to use with direct access

After you have adjusted and connected the PLC-VCOM or the programming adapter to the COM-

port on your computer, you will be able to connect with your programming software

to the PLC and work with it.

How you have to adjust your programming software is described in the following points:

5.1.1 PG2000 fiir S5 (V5.10)

1.Start the PG 2000 software by using the desktop link or by using the application entry in the start

menu.

mﬁrﬂnw Controller  Help

v Symbals

Wiew symbol comment
Symbaol and absolute operands

v use reference file
Select reference file...
Printer configuration...

Swmbols file L3
Footer File 3
Configurations. .,

Archiver

Addresses s-flags

Irterfaces. ..
PG path...
Language...

3

3. A dialog appears. In the section “Interface’
you can configure the “PLC — Interface*
(COM — Port).

4. Set in the section "Bus grip" the tick "Grip
allways only one block from PLC", "FB-
names", "Bst. Info" and "check "COM-Ports"

5. Save your configuration by pressing “OK*.
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Interface

AR PLCriterface:
Timeout (»=5500: [2500 e

Retias: ,3—
Tineoul between Data (220 me
STL mat execuled: [500  ms

Save file-bypdile v
Show Fropesties ot Load-lime [v

Bus arip

Iv Grip sways ool one block fiom FLC

I stat PLC access | FR.names [ Estinfo
¥ check COM-Ports

B auck ate: = | own fddiess |0
¥ PCMPI [187 SkBaw = |

Corwrct ower following Metwork-adagher;
[Intel 21143-basierter FCI-Fast Ethemetadapter (< = |

X

FTCP!IPtolﬂ.EI.!J.U J

ok | cemes | b |

2. Choose from menu "View" => "S5 155U-90 ..."

In the menu “Options* click “Interfaces®.
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6. Now the software is ready to establish a
connection to the PLC.

Fils
Click the symbol “Open‘ and afterwards press
TeleService “PLC”.

SH - Simulator
Alternative you can click “File* - “Open* - “PLC*.

PBrogrammer

LCancel

kR

[ AG[5] EIBE

[ | [oe[soef o[ rc]onssefsmc v & v m

Mark | Baustein Grofie | Adresse Bib-Nr Bausteinname ~ . .

iz Th tion between PG 2000 and the PLC

ST e connection between and the 1S
SFC 0t 0% READ_CLK .
SFC 006 2B FD_SINFO t bl h d
SFC 020 2% BLEMOV now cestablisned.
SFC 021 B FILL
SFC 022 L CREAT 0B
SFC 023 0w DEL DB
SFC 024 ) TEST DB . .
SFC 03 E) MSK_FLT Synchronehl
e S e sk | A new window appecars. Now you can edit the
sFC 038 a6 READ_ERR 2 i .
= : | blocks in the PLC.
SFC 01 B8 W DIE_ART
sFC 0i2 B8 W EN_alRT
sFC 043 5 0 RE_TRIGR
sFC 0as 1 sTR
sFC 047 B8 warr

o = s

5.1.2 SIMATIC Step© 5 Manager

1. Start your SIMATIC Step© 5 Manager by using the desktop link or the application entry in the
start menu.

[N Editer  Test 86 Uerwaltsns  Dokweatati 2. in the "File" menu , in submenu
E|WH "project” you can the "Setting" dialog
BAE Bobal % Clabaca Open.
|5 Optionen ¢ : o[ mum;n. I L
3. In the tab "AG" configure the used PLC interface IFAC T T S S

Detriebsart: BFfTing fenderbarkeit:

(example: "AS511").

Schnittstelle: AS511
Parameter: COM3:

Pfadname
Below that, you can set the COM port (example: "COM3"). :;::?;:g;sL.m.!.,j']'tuz"f“"-‘"“
adoption: in ) )

1 L P D A D G TS e e
< Waehlen F3>
< Maechste F& >

: <Info 1)

ENSBSENEISEREE < Abbruch ESC > < Projekt... Fé > < Hilfe Shift+Fg >
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&4 STEP 5 Window Mode - S5KX5012
T=\STEPS\S5_UATEN\HONAMEP R . INT
5 Optionen | & EPROM |7 aWL-Batch || |
J1 (17 ”? Bausteine “'3 Symbolik .'.i'e Dokumentation |
letriebsart: Onling fenderbarkeit: Zyklisch
AG-Typ: AG 100 B CPU-Kennung CPU 95C
Schnittstelle: AS511
Parameter: COM3:
Pfadname { 1
Pfaddatei HONAMEAP . TNT]
-» im Systemkataleg
Pfadoption: Hein
< Historie F1 >
[ 1 Aenderungen auch in Programmdatei aktuwalisieren < Editieren F2 >
< Waehlen F3 >
< Haechste Fh >
< Info F? >
EUEEEREENRENNE < Abbruch ESC > < Projekt... F6 » < Hilfe Shift+F8 >

4. with "F3" change, the "operating
mode" to "online".

The window should display the "AG-
type"

5.
"Online."

The connection with the PLC is successfully established when the "operating mode" changes to

5.1.3 Windows Control Center (WinCC) (v6.0)

1. Start WinCC by using the desktop link or the program entry in the start menu.

2. Choose ,,New” in the menu ,,File” or click on the white (,,letter”’) symbol to start a new project.

2]

i~ Create a Mew Project

B & Singlelser Project

%lfi " Muli-User Project

= o
B35 © Client Froject

% " Dpen an Existing Project

Cancal ‘

4. OK* leads you to a new dialog. Type in the
»Project Name* and the ,,Subfolder* of the
,Project Path*

With ,,Create* the chosen configuration is
confirmed.
If you want to use one of the other

options, please read this further in
the manual of the WinCC software.

3. The next dialog offers you several project
types ,,Single - User Project®, ,,Multi - User
Project” and ,,Client Project®.

The next steps are describing the ,,Single - User
Project™.

20
Progect Path
£ \picgekl
Froject Hame: Folder
|F'rn|:k| ]
Help
Nt Subloldar
|Proiek|
“fou can use the dulog box
Lo cieate & new WinCL .
peoject. Driye:
E C -

5. Please wait until the project is created. Afterward the project content is shown in the left part of

the main window.

Handbook USB-serial-converter cable
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& WinCCExplorer - H:\PROGRAMME\SIEMEN
File Edit Wew Tools Help

DS mw| § 2R 6. For a proper working communication with the
5 Projkt ' - o PLC there must be defined how the software has
(@ Computer to communicate with the PLC

Eﬂ]}]}] Tag Management
-7y Inkernal bags . .
-] SIMATIC 57 PROTOCOL SUTTE Therefore right click on ,,Tag Management* to

""" Few Driver Conneckion, .. OPCH the context menu. ChOOSe ”Add NCW
System Parameter Driver «

Slot|  Find,..
X TCP Paste

v-JB Indul  Properties

7. In the dialog ,,Add new driver* select the
driver which fits to your PLC

2 x]
uchen i ‘4 bin - -
Zsm; L:h s Js‘]‘ix:c iﬂc For a S5 PLC, you can choose the file SIMATIC
) therneal | el 8
] 5IMATIC 55 Profibus FOL. chn ] System infochin S5 Programmers Port AS511.chn.

] SMATIC 55 Frogrammers Fort ASS1L.CHN sl windows dde.chn

If you are using a different PLC please inform
yourself which driver fits with your PLC.

It is important that the chosen
driver fits with the PLC otherwise
the connection cannot be
established.

|
Dateiname: |SIMATIC 57 Protocal Sute Gfinen I

Dateityp: IW’mCC Commurication Diiver [%.che) =] Abbrechen |
i

8. In the explorer you should see into the
variable manager the branch "SIMATIC S5
PROGRAMMERS PORT".

Expand the branch and the protocols for several
connections will appear

Right click on the desired connection ,,S5-
ASS511%. A context menu opens. Click on ,,New
Connection...”.

9. Now you are able to type in the name of the connection. With a click on ,,Configuration a new
dialog will appear.

Set up the station address of the PLC (in this example ,,3%).

10. Confirm with "OK" until you are back to the main window.

11. Now you can with ™! start the communication and with ™. this end it again.

5.1.4 Windows Control Center flexible 2004 (WinCC flexibel) (v5.2.0.0)

1. Start the WinCC flexibel 2004 software by using the desktop link or the program entry in the
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start menu.

2. At first click on ,,Create an empty project™ in the ,,Start page*.

3. In the ,,.Device selection“mark the used
operator panel (example: ,,TP 170A*)

confirm with ,,OK*.

b Proect

= - _D:vm_'l['lF'ITEﬁ!
i -ege::zhmm

4. After the project has been created right click in the L Tenplate

[ Scizen 1

project window on ,,Connections* of the sub menu i
. . g!.
,,Communication‘.

i@ Cpcles Open edior

(=~ Alam Manegem Add Connection
B Drocreta dla

In the context menu click on ,,Add Connection®.

5. Right in the main window appears the new tab "Connections" where you are different settings
options.

Important for the connection are:

=> the communication driver (set up which PLC you are using
(eg: ,,SIMATIC S5 AS511%)

=> select the used "CPU - type" (eg "S5 95U")

=> configure the interface parameters in the section "terminal"
(eg: baud rate ,,9600, Parity,,even®, Data bits ,,8, Stop bits ,,1%).

5 Intelacn
O

HHI davicn Hetwork PLL davice

Tn:e Dsixd rate e PR, F

ol [ 3]

Qesw e Hhghest statioes adbess (HEA) Expuafuiion skt |

Qiesaaz Aodies t [z =] e F

2% = R
) BSAES
() Smakic Dlomiy master o1 the bz Pk cf racters g B Cche cperation 3
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6. Now you can start with your work.
Erofect [Edt ¥ew et Epmst Faoeplstes Opbons Hondow  Hep

O tiem ol e %,
Miei Project with Project Wizard = =

If you have finished work you can

B Cpen Chriel
o~ - E transfer this project to the panel by

sents ' reading the next steps.

Change Qe Type
& Bt ot Docurenlation .. ol
i e e 7. Choose ,,Transfer Settings* from the
T V(3 St zeers | sub menu ,, Transfer”.

8. In the new dialog change the ,,Mode* to ,,serial* and set the ,,Station address* of the operator
panel (e.g. ,,1%). Please set the baud rate to "19200". The "Delta transfer" is not supported by the
S5-LAN. Turn them so "Off".

E.SEIE[': devices for transfer | il
¥ Device_1 (TP 1704) ~ Setbngs for Device_1 (TP 1704] —
Tranzfer ta
% Flazh = REM
Mode MA/DF =] Deabants ————————
" On & 0
PLalien addess [~ Enable backbrarsfer
I™ | Ovemsitepesswond list
[~ | Ovenswite recipe dataecarnds
Transfer Apply Cancel
[ | I I,

9. Press the button ,, Transfer* to start communication with the terminal. Your project is about to be
transferred.

The communication with the operator terminal is so successfully established .

5.1.5 ProTool/Pro v6.0 SP2

1. Start ProTool/Pro by using the desktop link or program entry in the start menu.

2. Choose from the menu ,,File* the sub menu ,,New* or click on the right symbol.

Project Wizard - Device Selection ey 3 . The next dialog askes you Which Operator panel
Sekect the device pou ish 8 conlfigus you are using.

E (Geaphizs Displags o~
4 Touch Parwls

il Mark the used panel (e.g. ,,TP 170A%)

TP1F0E MOND

TP1TE COLOR

TRPZTO 6"

TRPEFOAT

OFi708

oFz e

oPzF T ~

[[ees | Fetioseien | abtescen |

4. ,,Next“ leads you to a new dialog. Type in the
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specfic fields the name of the PLC device and
choose the used PLC in the driver selection
(e.g. ,,SIMATIC S5 — AS511 V6.0%)

SIMATIC S5 - AS511 x|
CPU Ty

e [ U
Schoin shells:

G - |

- I Dsterbits |~ Famst Stopphitn |~ faudisle

= Fade -1 g P =1 g

Fadi oI " ' o

C A "t

= Re

N © e C -

5. Via ,,Parameter...“ you are calling an
configuration dialog from the chosen PLC driver

Select the used "CPU type" and the "interface" to
which the terminal is connected (eg "IF1 A").

Furthermore you configure the parameters of the
interface ("type", "bits", "Parity", "Stop Bits",
"baud rate").

7. confirm with ,,OK* until you got back to the ,,PLC Selection*“.Go on with ,,Next*.

8. In the main window start the Transfer Settings dialog by clicking on ,,File* ,, Transfer*
»ettings...“. Coose,,Seriall“ and the COM interface of the operating terminal (e.g.: ,,COM1). set

the baud rate to "19200".
Confirm with ,,OK*,

and start with your work

If you have finished working on this project you can go on with the next steps.

{ - SIMATIC ProTool/Pro CS DEMO - T
HEN Edit  View Insert  System  Options

ChrlH-M
CtrHO

Mew,..
Open...
Close

Save Crl+
Save As...

Convert »
Integrate in STEP 7 project...

Copy from STEP 7 project...

ProTool Integration in STEP 7

Replace 4

Ctri+G

Compile. ..

10. To transfer the project just click on ,,File*
»Download* ,,Start Project Download* or click

on the right symbol@.
Please wait while the project is transferred.
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9. If you want to transfer you project to the panel
you have to generate the project first. This can be
done with a click on ,,File* -,,Compile®.

{" SIMATIC PraTool/Pro CS DEMO - Test

File:
Tdew. ..

Cpen...
Close

Edt ‘Yew [Insert System Options ‘Window 3
ek E
Chels0

2 B | v o |

SEvE A2,
Conyest 3
Integrate in STEP 7 project...
Copy from STEP 7 project. ..
v ProTool Integeaton in STEP 7
Reploce ¥

| Kumber Starl

Compils, .. Tl

Upload 3
Iest ¥

Start Project Download  CrbeT

Backup...
Bestore. ..
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The communication between the operator panel is now established.

5.1.6 S5 for Windows v5.02

1. Start the “S5 for Windows” software by using the [ls5 / 57 for Windows® - [PC
link on your desktop or use the link in your start menu M[Ele Dock gotions ddow
y P Y
(standard is “Programs\S5 for Windows\S5 for ;2 32“;’“,” il
Windows*) 2 e Fiz
Efe s
2. Choose File - >Preferences... (top left in the menu B Etaiitlcs -
bar) to configure the communication configuration —
between the computer and the PLC. Export..,
Programm File »
3. A new dialog appears which offers the possibility to Symbolic Table File >
set up a lot of configuration data about the 7 Configuration dafa >
communication with your PLC. Compare two Files
Preferences. .,

x
Interfzce |Editnl I Statusl Listingsl Frezentation Fontsl Miscellanenusl BIDckDiffI
 Preferences from: — Serial Port:

~ PC " Project File CEOH
= 900
~PLE Type: " COM 2 13200
* ¢5 57 " COM3 " 33400
-
— Praotocal: & COM4 - :?ggg
¢ A5511 [Simatic-55) ThE e 1;52["]

" 55.- SoftPLC extamal

{55 /57 - SoftPLZ internal ¥ iy Master at the Bus
" INAT TCP/P - Automatic 57w 21 Address: I il

Connection
 INAT H1 MPI Address PLC: I &
" SimaticMET [Simatic-57)

" MP| Corwerter Cable  [Simatic-57)
Test Connectior during save: I b2 PP Addclress: 15 =

— MP| Corpeerter:

Select PLC |

Default Settings: —————————————
ak I Abort | Help | ’7 Beload | Save |

4. Choose the first registry card ,,Interface (standard) and set up the configuration data as
descriped below:

=> Interface Settings from : ,,PC*

=> PLC type: ,,S5“

=> Protocol: ,,AS511 (Simatic - S5)

=> Serial Port: Select here the COM port for the AG-access
=> Baud Rate: Choose the speed you want to use at the bus

4. 5. After the software is configured , click “Select PLC” in the area “MPI Converter. A new
dialog appears where you can select the desired PLC
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Select PLC d 3
Available MPl-&ddiesses: PR

5. In this dialog you can see all PLC’s
which are connected to your PC.

Choose from the list box (left) the desired
station (the PLC) and confirm with "OK".

(In the example "2")

6. Close the preferences dialog by pressing
the ,,OK* button.

7. Back in the main window press the ,,PC Block List*
button for testing the new established communication
configuration.

8. 9. Please wait a moment for the software to read the
desired blocks from the PLC. The blocks will be
displayed in the listbox below the menu bar (see
picture to the right).

The communication between the S5 for Windows and the PLC is now established.
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SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
SFC
il

Baustein

0
1
2
3
4
20
21
22
28
29
30
31
32
33
34
36
37
38
39
40
41
42
43
44
46
a7
49
50
51

Adress
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6 Technical data

Supply voltage: 5vDC

Power consumption: 0,2 watt

Display: 2 status-LEDs for RXT/TXD
to the PD/PC:

Interfaces: USB 2.0 cable type A
others:

RS232:300Bd - 115,2 KBd
Operating temperature: 0 - 55°C
Case: metal case
Dimensions: 60 x 30 x 14 mm
Scope of delivery:

USB-RS232-converter-cable

6.1 Pinning (USB) PC

Pin No. Short form Description Direction (cable — view)
| Vce Power supply (DC) In

2 D- Data line — BiDi

3 D+ Data line + BiDi

4 GND Ground In

Important:

Please do not lengthen this side, this side also supports the 5V/DC power supply (max. cable length
are 5 meters)

.

e
AR
Hud

A longer cable would decrease the quality of the signal on the bus and may cause several
errors in the transmission!

6.2 Pin assignment RS232

Pin number 9 pole  Short form Designation Direction Pin number 25 pole
1 DCD receive line signal detected  input 08
2 RXD receive data input 03
3 TXD transmit data output 02
4 DTR data set ready output 20
5 GND signal mass input 07
6 DSR transmission means ready input 06
7 RTS request to send output 04
8 CTS clear to send input 05
9 RI callsign input 22
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7 Troubleshooting

7.1 Troubleshooting

When trying to run the installation appears an error message that this software is not
executable under the operating system XP/NT/2000.

The SSVCOM driver is ONLY required for Windows 95/98/Me. The other operating systems like
Windows XP/2000 have integrated this driver in the operating system and do not need it.

A message appears that the PG-USB driver is not installed.

The SSVCOM driver is based on the standard Windows drivers for the PG-USB-cable / USB-
RS232-cable so that needs to be installed first. Plug in the PG-USB-cable /USB-RS232-converter
into a USB port and follow the installation instructions. (The driver is on the CD)

While copying files appears an error message that copying is not possible.

This can have several causes. Possibly you not have enough space left on the hard disk, the program
is already installed or the tray icon is still running.

After restarting the computer appears a message that the Settings.ini could not be opened.

In this file in the installation directory of SSVCOM driver settings are saved. This file is missing (It
is created at program end), it is write protected or you do not have write permissions for the file.

After restarting the computer appears a message that the driver failed to load and the
program ended.

There was no meaningful COM port to be found, so that the driver failed to load. Start a MSDOS
box and type in:

,.debug <ENTER>*
,,d 40:0<ENTER> ,,

It appears a hexdump of the BIOS configuration area (where the existing COM ports are displayed)
Then enter "q < ENTER >" to exit the program:

Elomdee 00000 -0 x|

TaE®
=
=
wrfamunfonTun =
& 5 D
)
oEDEED

In the first 4 * 2 bytes in the system stands the COM ports are known:

F8 03 COM1
F8 02 COM2
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E8 03 COM3
E8 02 COM4
00 00 Empty entry (here not available)

In our case there is simply no more free COM port. When an empty entry is present, then cant be
used only the required for this IRQ.

COMI1 and COM3 uses both the same [RQ4
COM2 and COM4 uses both the same IRQ3

S5VCOM uses COM3 in the DOS box, but my S5 software can only use COM1 or COM2 (eg.:
S5 V3.02)

Try to integrate in the system the from system existing COM 1/2 interface as a COM 3/4 (possibly
by a jumper).

My Windows software can not access the PG-USB-cable / USB-RS232-converter, although this
is set in the control panel correctly and it worked before. It appears the error message that the
COM port is already occpied or is not accessible.

The SSVCOM driver opens this COM port to communicate about even if no MSDOS box is open.
The Windows program would now like to open the same COM port. This fails.

Quit the SSVCOM program (tray icon), thereafter an access from Windows is possible here, but
from a MSDOS box is not. By restarting the program out from the startup folder, then can be
worked under MSDOS again. Access under Windows and under MSDOS exclude each other!

It still works not, though the driver is loaded and the tray icon appears.

Double click the tray icon and select from the system menu "Information about ..."

17 €5 ¥Com L -0 x|
= Wiederherstellen
Verschishen IF'I ity alid corfigure |

Grifie Andern

= Minimieren

O Maximieren

X SchlieBen Alt+F4
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S5¥Com Info

0 0 — | —— 00—

Statistics: o
Acks migzing : 0
Ackzsaved 10

[T LOGtaFile [ Time
[ Double-Buffer

IV FxPrio [ TPria
SerMr |

¢ "WCOMLOG) USBLOG| DBGMan |

I o—

The corresponding dialog is displayed.
In this is also the version of the driver.

Right click over the image.

- It appears additional control elements where you click ONLY on the

button VCOMLOG!
Confirm with "OK".

In the installation directory of SSVCOM was generated the file
"VCOM.LOG".

Send this to us together with the version number and description of the
problem.
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